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SKCCLogger User Guide
This guide contains the following chapters:

l Getting Started
l Logging
l Editing and Deleting Log Entries
l Managing Multiple Radios
l ADIF Log Files
l The Tools Menu
l Appendices

Getting Started
The following subjects will get you started:

l Downloading Membership Data
l Setting Program Options
l Connecting to a Radio
l Starting a Log File
l The File Menu
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Downloading Membership Data
If your PC is connected to the Internet, you should download a current membership data file from the SKCC Web Server.
Whenever the SKCCLogger starts, the program checks to see the age of the local copy of the SKCCMembership Data file. If it is older than a specified age, then you will be prompted to download an up-to-date copy of the membership data. The following prompt will appear upon initial program load.

Another option to download a current copy of the SKCC membership Data file is to select the "Update Membership Data" from the Main Window "Options" menu.

When you select the "Update Membership Data" menu item, the "Download Membership Data" window will open. The application should auto-start the download after a short delay of a few milliseconds - if it does not autostart, Press the "Start Download" push button and watch the progress as the program connects to the Internet, downloads the information, and creates a local database from the information.

As a final step in the Membership Data File download, the program automatically checks for program updates and will inform you if an upgrade is available for download.
Once the "Done" push button appears, you can press "Done" to close the window.
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Please Note:
You can also access the Download Membership Data window from the Program Options Window or simply by clicking on the Membership Database Status label in the main window.

Next Chapter: Setting Program Options

Setting Program Options
The first thing you should do is set some program options and update the membership file.
This program utilizes two primary windows: a main window that carries the full listing of QSOs, and a Log Entry window, which appears after you click on the main window's "Start Logging" button. To begin program set-up, from the main SKCCLogger window select the "Options" menu item and then select "Set Program Options."

When you select "Set Program Options," the "Program Options" window will open. Here, you can specify the following options:
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Logging Defaults
l Enter default values for RST Received, RST Sent, and TX Power. These are optional settings that you can use to speed the logging process - you may leave the fields blank if you prefer. 
l You also should update the Membership File with the latest information. Make sure your PC is connected to the Internet, then click on the "Get Member File" to download the latest information to update SKCCLogger's "skccdata.txt" file. If you have a slow Internet connection, you may want to adjust the "wait time" (see below). 

¡ Note: Many PC firewalls will prevent an application from accessing the Internet without your permission. If the membership-data download does not start quickly, please check for any messages from your PC's firewall.
My Station

l Some users have requested that their Callsign and SKCC Member number be displayed in the Title of the Add Log Entry window. That places the information immediately in front of them while logging a QSO. You do not have to enter your callsign into the "My Callsign" text field. You can leave it completely blank, if you want. Entering your callsign here allows the program to display your Callsign and SKCC Number in the Add Log Entry Window. 
l Entering your Gridsquare is optional. If entered, it will be added into each log entry and will be added to your ADIF log file. A non-blank Gridsquare will be validated as follows:

¡ It must be either 2, 4, 6, or 8 characters in length. 
¡ The first and second charaters must be alphabetic and range between A and R. 
¡ The third and fourth charaters, if entered, must be numeric and range between 0 and 9. 
¡ The fifth and sixth charaters, if entered, must be alphabetic and range between A and X. 
¡ The seventh and eighth charaters, if entered, must be numeric and range between 0 and 9. 

General Program Options
l Checking the "Copy SKCC Number to Comment Field" tells the program to copy the SKCC Number, Name, and SPC for members to the Comment field. This ensures that you can carry a member's SKCC number to other logging programs. 
l The "Refill Log List After Window Resize" option tells the program how to behave whenever you resize the main window. If youcheck this option, the QSO list in the main window will be refilled so that the latest entry is displayed as the last line on the list. You may want to play around with this option to see which setting you prefer. 
l By default, the SKCCLogger will remember and recall the last position and size of many of the windows that the program uses. If 
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you do not want this option, just uncheck the checkbox next to "Remember Window Positions Sizes." 
l Although this logger was specifically designed for use in logging SKCC QSOs, you can use this program to log general QSOs in modes other than CW. Checking the "Enable Logging Modes Other than CW" option will provide a Mode drop-down list to appear in the Log Entry window. 
l With the "Recent Logs List: Maximum Count" option, you can set the number of recent logs the program will maintain on the File Menu's "Re-Open Recent Logs" list. 

¡ You can specify any number between 2 and 25. 
¡ Note: If you have more log files than the number you specify, the list of recent logs will start with your most recently opened log, then be trimmed to the number of logs that you enter.

l The "Membership File Age Reminder" option allows you to specify how often you want the program to remind you to refresh the membership list (minimum of 1 day). On start-up, the program looks at the age of the latest membership file in the program directory and will remind you to refresh the list if its age exceeds the value you specify here. 
l When you request the membership data file from the SKCC web server, the program will wait a certain amount of time for the download to complete before abandoning the attempt. With the "Maximum Wait for Web Download" setting, you can specify a wait time of 30 seconds or more. The default value is 60 seconds. If you set a value greater than 180 seconds, the program will display a warning. The message is informative only and will not prevent you from setting any value you desire.

l The default font used for all Text Fields in the SKCCLogger is the "System" Font defined by your PC's Operating System. Some users have found that different fonts make the displays easier on the eyes. You can experiment with fonts here. Please note the following: 
¡ Any font you select is immediately used to fill the text fields within the Program Options Window. This gives you a quick preview of what the font looks like. 
¡ If you want to select a different font, your MUST "Save" your settings before closing the Program Options Window. 
¡ When you change the font, the new font will be applied only to the Main SKCCLogger Window. Any other open windows will need to be closed and re-opened in order to display using the newly selected font. 

Logging Type
You must also select a "Logging Type", which affects the behavior of the SKCCLogger program as follows:

l "Sprint Logging" enforces strict logging requirements for a SKCC Sprint. This setting requires you to enter a Date & Time, Frequency or Band, Callsign, Name, RST Sent, and RST Received. 
l "General Logging" relaxes logging requirements to require only Date & Time, Frequency or Band, and a Callsign. 

Log List Columns
On the right side of the "Program Options" window you will find a list of the columns the main window's QSO list can display. Use the checkboxes to customize the amount of data the log dislays - especially useful on older machines with smaller screens.
Note: All of the fields on the checklist are saved in the log file whether or not you select them for display. Also note that the Row ID, Date, Time, and Callsign are not optional display items.
When you are done, click the "Save" button to save your settings and close the Program Options window.

Next Chapter: Connecting to a Radio

Connecting to a Radio
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If you have a supported radio connected to your PC, you will want to tell the program about your radio so that the logger can read and set the VFO for you.
From the main SKCCLogger window, select the "Options" menu item and then select "Configure Radio."

When you select the "Configure Radio" option, the "Radio Setup" window will open.
The "Config Name" pull-down menu provides you with a way of naming your radio configuration. Providing a unique name for your radio configuration is most useful when you have two or more radios that you use with the logger. However, even with one radio connected, you need to assign a name to the settings.
If you have previously had a radio connected with an early version of the SKCCLogger, that radio's setup will be recalled, preset, and will be given a default name of "My Radio Setup" as shown in the image below. You will be able to change the configuration name later. But for now, just continue.
If you have never configured a radio before, you will start with a "New Config." In this case, you will be prompted later (when you try to open the port) to provide a configuration name.
The two different initial scenarios are shown in the following screenshots:

Details on managing multiple radio configurations is provided in the Managing Multiple Radios chapter.
The following steps will connect the SKCCLogger program to your radio:

l Click the pull-down menu next to "Radio Model" to see if your specific radio model is supported. Selecting your radio model will preset certain settings and also display a small set of helpful information specific to the radio model selected. 
l Click the pull-down menu next to "COM Port" and select the specific COM port that your radio is connected to. Only COM ports that are currently available through your operating system will appear in the menu listing. 

¡ Note to Linux Users: If you intend to run this program on Linux via Wine, please see "Note to Linux Users" in the Appendix before proceeding with the rest of this step.
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l Click the pull-down menu next to "Baud Rate" and select the baud rate as set in the menu system of your specific radio. Only Baud Rates that are valid for your selected radio model will appear in the menu listing.
l Click the pull-down menu next to "Parity" and select the parity setting required for your radio. If unknown, leave as set by the program or select "None." To date, none of the radios supported by the SKCCLogger use any parity bits. 
l Click the pull-down menu next to "Stop Bits" and select the value required for your radio. If unknown, leave as set by the program or select "1.0." 
l The Icom interface uses a "CI-V Port" address that is unique to each model of radio. Unless you have changed the default setting for your Icom, the default value provided by the program should work. The "Icom CI-V" text field will be disabled (grayed out) and preset to "N/A" unless an Icom radio using the CIV protocol has been selected. 

Some radio interfaces use either hardware or software "handshake" controls so that the radio can control when the PC can interact with it. The Radio Setup window provides options to select any of five different types of handshake interfaces. The checkbox options provide thefollowing:
l CTS-FC enables CTS/RTS Hardware flow control; 
l DTR-FC enables DTR/DSR Hardware flow control; 
l Xon/Xoff enables Xon/Xoff Software flow control; 
l DTR ON causes the DTR control line to be asserted; 
l RTS On causes the RTS control line to be asserted. 

Once you have entered all required information, the "Open Port" button should be enabled. Click the button to open the port to the radio.
If you are setting up a "New Config," the program will prompt you to enter a name for the configuration. Enter any descriptive name you like. Just note that all radio configuration names must be unique and that "New Config" is a reserved name. Press the "Save Name" button when you have entered your configuration name.
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If the COM port opened successfully, the message "Radio Port Opened" should appear under the "Open Port" button and the button should now be a "Close Port" button.
If the COM port failed to open, check your settings carefully and try again. A common reason (in fact the ONLY reason I have seen sofar) for failing to open is that the COM Port is already in use by another program - maybe another logging program?
You should also be aware the a successful opening of the COM port ONLY means that the logger has connected to the port. Proper exchange of information through that port is a different challenge altogether.
If you are certain that all other settings are correct but you still cannot read or write to your radio's VFO-A frequency, you may want to experiment with various flow-control settings. Keep in mind, however, that opening a COM port on a PC does little more than connect the COM port to the program that opened the port. No data is actually passed at this point.
The next steps actually use the COM port to communicate with the radio.
Once you have opened the radio port, the next step is to test setting or reading the primary VFO.

l Click the "Read VFO" button to send a command to the radio. 

You might see some data displayed in the "Raw Data Received From Radio" text box, but it is probably not important to you. If the radio responds as expected, the frequency (in MHz) should display in the text box directly above the "Set VFO" and "Read VFO" buttons.
Note: The "Copy to Clipboard" button can be used to copy/paste all of the data displayed in the "Raw Data Received From Radio" to the Windows clipboard. In the event that you have problems with your radio interface, the software-support team may request that you send a copy of the data being sent from the radio. This button makes it easier to transfer the data to an email or text file.
If the COM port opened successfully, but you are unable to read or set the VFO, then you need to carefully check the various settings that you selected above:

l Make certain that you have selected the correct COM port - the one that actually connects to the radio. 
l Make certain that there is a cable connecting the COM port to the radio and that all cable connections are firmly in place.
l Check the baud rate to make sure it matches the baud rate set in the radio. Check you user manual for "CAT" control instructions. 
l Try various stop-bit settings and flow-control combinations. 
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Once you have set the COM port parameters correctly and have successfully read the VFO frequency, you should be able to enter a frequency into the text box and set your primary VFO.
When you are connected to a radio and start logging with "Auto Freq and Band" enabled, the program will periodically read the frequency from the radio. By default, the radio is polled for data every 15 seconds. You can specify a polling rate (in seconds) with a minimum of 1 second and a maximum of 999 seconds allowed. The default rate is once every 15 seconds.
When you have completed setting up your radio, click on the "Close Window" button to exit and leave the radio connected.
DO NOT click the "Close Port" button unless you want to deactivate the program's ability to read and set your radio's VFO.
Don't worry about trying to remember the specific settings you used to connect to the radio - the program remembers the settings in itsinitialization file.
When you exit from the Radio Setup Dialog window, the main logging window should reappear.

Next chapter: Starting a Log File

Starting a Log File
Before you start to log Sprint QSOs, you should start a new log for the Sprint. The program can handle large ADIF log files, but it is currently designed to use smaller log files with only a few hundred entries. You should get into the habit of starting a new log file for each sprint. You can merge them later with any master log you may be keeping with SKCCLogger.
To start a new log file:

l Select "Start New ADIF Log File" from the File menu in the main SKCCLogger window. 
l You will see a "Create New ADIF Log File" dialog box that should show the current contents of the folder where your current logresides. By default, logs are created in the 'C:\SKCCLogger\Logs' folder. If, for whatever reason, the opened directory is not the folder containing your current log file, use the navigation tools to navigate to the correct directory. 
l Enter the name of your log file. For example, one common format would be "yyyy-mm-dd WES Log.adi." But whatever you pick, 
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it should work fine. If the file name you enter does not exist, SKCCLogger will create it. If you enter or select an existing file name, SKCCLogger will warn you that the file exists. If you select an existing file anyway, SKCCLogger will erase it and the file will open empty - be careful what you request. 
l Once you have created a new log file, the "Create New ADIF Log File" dialog should close and the log file name should appear in the lower left corner of the main window.

Note from the SKCCLogger Author, AC2C
Over the past few years I have been asked several times for advice on how to organize log files. There are many ways to do this and I offer here advice based on how I handle my logs - do whatever works well for you. As mentioned previously in this User Guide, the SKCCLogger was originally developed to serve as a sprint logger - logging a single SKCC sprint event. In fact, the sprint statistics displayed in the lower right corner of the main log display window ASSUME that the current log represents a single sprint event. If your log spans more that a single sprint event, then those numbers are of little use to you.
There are many logging prograns available for you - shop around and settle on whatever you like. Personally, I currently use Ham Radio Deluxe (HRD) as my master log program - ALL of my radio activity is contained in the HRD log file. However, I use the SKCCLogger throughout the month to log my SKCC activities. Here is what I do - take it for whatever it's worth to you:

l At the beginning of each month, I create a log file for my monthly SKCC activity. This log is named 'SKCC-AC2C-mm-yy' and this log will, at month's end contain ALL SKCC activity for the month. 
l For any special sprints or other activities during the month, I create a separate log for each SKS-E, WES, SKS, or other event.These individual logs then provide immediate statistics for the event that I can use to submit to the SKCC webpage as my activity for the event.
l Following each special event and my submission, I then use the File menu "Merge Log" function to merge the sprint log into my monthly log.
l Continuing this process for each sprint/event during the month, by the end of the month I have a few logs that were used for each sprint/event but I also have one log that contains ALL of my SKCC activity for the month. I can use that single log to create my "Monthly Brag Submission" and then merge that log into my HRD master log for upload to LoTW. 
l As a final step at the end of each month, I merge my monthly log into an SKCC Master Log that contains ALL of my SKCC activity since I started tracking it. This SKCC Master log file is used as the basis for applying for various SKCC awards. 
l As they say in the ads, your mileage may vary (YMMV), but that's what I do. 

Next chapter: The File Menu

The File Menu
In addition to the "Start New ADIF File" option, you have other options under the File Menu as well.
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l "Open Existing ADIF Log File" allows you to open an existing log. After the log opens, new entries will be appended to the file. 
l "Print Log Data" allows you to print out the current log. The text format is fixed as Courier, 8-point font, and you should print in Landscape format to maximize the data a page displays. An ellipse (...) at the right-most end of a line indicates that additional information has been truncated. 
l "Save Log" saves the current log file to capture any changes made since the last save.
l "Save Log As ..." saves the current log "as is," gives it a new name, then continues using the new log file. 
l "Save Selected As ..." will save highlighted rows in the main window to a fresh ADIF log file. By using the "Merge ADIF File Into Current Log" function (see below), you can add these entries to an existing log. 

¡ You can select or de-select individual rows with a CTRL-click and select a range of rows with a SHIFT-Click.
¡ Be careful: If you attempt to use the "Save Selected As ..." function to save directly to an existing log, you will overwrite theexisting file and it will display only the entries you are trying to transfer. If you try to save selected entries directly to an existing file, you will see a warning asking you if you really want to overwrite the existing file. Again, save the selected entries to a new file and use the merge function described below to add them to an active log.

l "Export to Excel-Format CSV File" saves the current log file data to a comma-delimited text file that can load into MS Excel or other compatible spreadsheet programs. 
l "Export to Pipe-Delimited Text File" saves the current log file data into a pipe-delimited text file. The text file can easily be examined and manipulated with a simple text editor or with a spreadsheet program, such as MS Excel. 
l "Merge ADIF File Into Current Log" merges an existing ADIF log file into the current log file. This option provides a way to combine multiple log files into one master log. Note that duplicate log entries (same Date, Time, Callsign, and Band) will not be added to the current log. 
l "Re-Open Recent Logs" allows you to quickly find and re-load recently opened log files. The number of recent logs is five bydefault or the number of logs you specified during program set-up. 
l "Clear Recent Log List" will delete all except the current log file from the recent-log list. 

¡ You can specify the number of recent logs to be maintained via the Options menu in the SKCCLogger's main window.
l "Exit" saves any changes to the currently active log file and shuts down the SKCCLogger program. 

Next section: Logging

Logging
The SKCCLogger was designed with the "keep it simple" principle in mind.
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Logging can be:
l Completely manual, requiring you to enter every detail;
l Semi-automatic, requiring you to enter some information; or 
l Fully automatic, requiring minimal data entry. 

The SKCCLogger program can:
l Get the current date and time from the computer. 
l Get the frequency and band from the radio - if connected and configured. 
l Get a member's SKCC number, name, and SPC from the membership data list. 
l Use the preset defaults for RSTs and TX power that you specified during set-up.
l Copy the member's SKCC number, name, and SPC to the Comment field. 
l Use "Enter" as the default action to add a log entry or require that you press a button to add an entry. 

All of the above actions are options that you can select to suit your specific logging style and needs.
The following subjects in this section will get you started on log entries:

l Logging a QSO
l Logging Alternate/Past Callsigns
l Sprint Logging
l Tracking Sprint Statistics and SPC Details
l Timing the Length of a QSO

Logging a QSO
Once you have set program options, configured a radio interface (if you have a radio connected), and opened a log file, you are ready to start adding QSOs to your log.
To open the Log Entry window, click the "Start Logging" button on the main window.

Many options and variables can affect how you use the Log Entry window and how the Log Entry reacts to your actions. Let's take a moment to look over the basic window and discuss the options available:
l Some users want a logger to auto-fill as much as possible, while others want to fill everything manually; 
l Some users want to Tab from field to field, while others want to use the Enter key to move from field to field; 
l Some users want to log various modes, while others want to log CW only; 
l Some users want to have the Enter key be the default key used to complete a log entry, while others want to log only when they specifically click a button.

It is difficult to create a program that suits everyone's desires, but I have tried my best to be as flexible as possible.
When the Log Entry window is first opened, it should look much like the image below. Some minor differences between what you see 
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and what is show below are:
l If you have configured and connected a radio: 

¡ The "Read VFO" checkbox will be checked; 
¡ The "Freq" and "Band" fields will be disabled and will display the data from your radio; 
¡ The "QSY" field will be enabled.

l If you have not checked the "Enable non-CW Logging Modes" option in the Program Options window, then the "Mode" drop-down list will not appear.

A Quick Overview of the Log Entry Window
The first time you open the Log Entry window, you may be confused by all the buttons, labels, and text fields. Before you start making your first log entry, let's take a quick look at some of the fields and controls available.

l For real-time logging, checking the "Auto Date & Time" checkbox above the Date and Time fields will read the date and time fromthe PC and enter the information for you. When checked, the text fields are auto-filled every 60 seconds and the fields are not editable. Anytime you want to enter a manual value, just uncheck the "Auto Date & Time" checkbox. Real-time logging mode is the default mode whenever the Log Entry window is opened. 
¡ Once you have entered a call sign into the Call text field, the Date & Time are frozen and not automatically incremented until the log entry is completed or the Callsign field is otherwise cleared. You may click the "Now" button at any time to update the date and time entries to the current date and time. 
¡ Note: The Date format presented and expected in the Date window is defined by the format you specified in your PC's Regional Settings set-up in your Windows Control Panel. Depending on your location and specific operating system, a variety of date formats are available. For example, the date 4 July 2012 could show in any of the following formats:      07/04/2012 in MM/dd/yyyy format      04/07/2012 in dd/MM/yyyy format     12/07/04 in yy/MM/dd format      2012-07-04 in yyyy-MM-dd format      04.07.2012 in dd.MM.yyyy format      etc, etc, etc 

l If you have configured and connected a supported radio, you may click the "Auto Freq & Band" check box located above the Freq/Band fields. If checked, the program will periodically poll your radio and update the frequency and band based on the information read from the radio's VFO-A. You designated the polling rate in the "Radio Setup" window. As you manually tune the radio, the displayed frequency and band information will be automatically updated.
¡ Note: The "Auto Freq & Band" checkbox is not selectable unless you have configured a radio and have opened the COM port. Whenever a radio is connected, "Auto Freq & Band" is the default mode when you open the Log Entry window. 
¡ If you have connected a Radio, you can quickly QSY (i.e. set VFO-A) by entering a frequency into the "QSY" field and 
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pressing TAB, ENTER, or the "QSY" button. 
¡ Note: If you turn (scroll) your mouse wheel while the QSY text field is selected (has the current "focus"), the SKCCLogger will increment or decrement your VFO-A Frequency at a rate of 100 Hz per wheel click. 
¡ The "Auto Clear" checkbox located above the "QSY" field affects the behavior of the text field whenever the cursor enters the field. If checked, the field will clear and be ready for a new entry. If unchecked, the field will retain its previous value and will be ready for editing. SKCCLogger remembers your preference after the window is closed. 

l The Mode drop-down selection will be visible only if you have selected the "Enable Logging Modes Other than CW" option in the program's Options window. The following operating modes are supported: 
¡ CW 
¡ AM 
¡ FM 
¡ HELL
¡ JT65 
¡ JT65A 
¡ JT9 
¡ OLIVIA 
¡ PSK31 
¡ RTTY 
¡ SSB 
¡ SSTV

l Please note the "Auto-Fill" checkbox located half way between the Name and the City text fields. Check this box if you want the program to fill log fields based on information contained in the SKCC membership file.
l Now note the "Run" button located between the "RST Tx" and the "RST Rx" entry fields. 

¡ This button allows you to select your sprint operating mode as either "Run" when running a frequency, or as "S&P" whenoperating in search-and-pounce mode. 
¡ Normally, when "running a frequency" you will sit on a frequency and call CQ. In this mode, you would typically send a RST report before receiving your own, so your RST Tx would be logged before your RST Rx. 
¡ On the other hand, when operating in S&P mode, you would be looking for others calling CQ and calling them. In this mode, you would typically receive an RST report before sending a RST report, so your RST Rx would be logged before your RST Tx. 
¡ Pressing the "Run" button will swap the order of the "RST Tx" and "RST Rx" fields, and the button label will change to "S&P". 

l You will also notice the "Auto Log" checkbox located to the left of the "Log It" button. When selected, the ENTER key becomes the default "Log It" action whenever the minimum required logging information has been entered. 
l Finally, please notice the "Show Partial Matches" checkbox located directly above the "Previous QSOs with Station" List Box. When selected, the program will search the current log for QSOs with the same callsign as the callign is entered character-by-character. 

Now, with these options in mind, let's look at logging a QSO.
For general logging, the program requires you to enter a minimum amount of information before it can be logged. This information includes:

l Date and Time 
l Frequency OR Band
l Callsign 

Next, enter the callsign of the station being logged and press Tab (or ENTER). If you have checked the "Auto-Fill" checkbox, theprogram will auto-fill the following fields based on the SKCC membership information for the callsign entered: 
l SKCC Number 
l Name 
l City
l State 
l Country 
l RST Sent 
l RST Rcvd 
l DXCC Code 
l TX Power

After entering a callsign in the "Call" field, you can either tab out of the field or press the "Check" Pushbutton (Alt-M) to retrieve and auto-fill information retrieved from the membership list. At this time, any previously logged contacts with this station will be displayed in the list box. QSOs with the same station on the current band will be listed in bold font and labeled as "DUPE."
l Note the following actions regarding the Previous QSO's with Station List: 
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¡ If the "Show Partial Matches" checkbox is selected, then callsigns that are "LIKE" the callsign entered will be displayed. 
¡ Once a callsign has been finalized, then all previous QSOs with the same Call will be listed but previous QSOs with the Same Call on the Same Band will be highlighed with a reddish background. 
¡ You can double click on a specific Previous QSO to open the QSO in the Log Edit Window. 
¡ You may notice callsigns listed that are different that the callsign entered. This can occur when the member being logged has changed their callsign and you logged the member the previous callsign in the current log file. 

l You may Double Click on any Previous QSO listed to open the QSO Details in the Edit Window.
You may also press the "QRZ" Push Button (Alt-Z) to launch a small browser window containing the QRZ.Com webpage information for the callsign entered.
Alternatively, if you hear a SKCC number but missed the callsign, you can enter the SKCC number in the "SKCC" text field and press the "Check"pushbutton (Alt-N). There is no need to enter the "C" or "T" suffix with the SKCC number to find a match.
Note that the State/Country information is actually a best guess based on the information contained in the "SPC" field of the SKCC membership data file.

l If the value in the SPC field is one of the standard USPS abbreviations for a US state or US possession, then the SPC value is used as the state and United States is used for the country.
l If the value in the SPC field is one of the standard abbreviations for a Canadian province or territory, then the SPC value is used as the state and Canada is used for the country. 
l Otherwise, "DX" is entered as the state and the SPC value is used for the country. 

A Few Notes About the DXCC Field
l The Logger uses the DXCC Code Value ONLY when processing a DXC or DXQ Award Application. 
l The Logger fills in the DXCC Field based on information contained in a special membership data file. This special data file is the one downloaded and used by the Award Processor. If you have never run the award processor, then the data is based on membership data that was loaded when you installed the SKCCLogger on your PC. 
l The only time that you need to enter or change the DXCC Code value is when the member is operating away from his or her home QTH. 
l If you Click on the underlined "DXCC Code" label, the program will open a Browser window displaying the current DXCC list provided by the ARRL.

Anytime that an Auto-Fill operation would enter data into a field that already is filled, the program will ask you how you want to handlethose filled fields. You have three options:

l Overwrite All will fill in membership data into all fields.
l Fill-In Blanks will fill in only fields that currently are blank. 
l Leave As-Is will leave all data fields as they currently are. 

Once all required fields (either General Logging or Sprint Logging) have been entered, the "Log It" button should be enabled. Clicking the "Log It" button will enter the QSO information into the Main Window log list, clear all fields (except for Date, Time, Freq, and Band), and place the cursor into the Callsign field.

Note: There are six buttons on the Log Entry window and there are (Alt + Key) shortcut combinations for all except the Log It and Closebuttons:
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l Alt+C (or Escape) for Clear All 
l Alt+M for Check Member Call 
l Alt+N for Check Member Number
l Alt+S for Save Log Entry 
l Alt+Z for QRZ.com Call Lookup 

Next chapter: Logging Alternate/Past Call Signs

Logging Alternate/Past Callsigns
Over the years, many SKCC members have changed their call signs. Several members also have one or more alternative call signs.
Some members use the same SKCC membership number with more than one call sign. SKCC membership records always identify one call sign as the "Primary" call and all others as an "Alternate" call for the member.
When you enter a call sign in the Log Entry window's Call field, the program searches for a member with a matching "Primary" call sign. If a matching record is found, then the membership information for that callsign is used.
However, if a membership record with a matching "Primary" callsign is not found, then the program searches the membership records for a member with a matching "Alternate" call sign. If a member record is found, the program will present a dialog box requesting that you select which call sign you wish to use for the log entry.
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Select which call sign you wish to use for the log entry by selecting the appropriate button.

Next chapter: Sprint Logging

Sprint Logging
The SKCCLogger is designed to use the "Tab" key to move from one field to the next. Although you may also use the "Enter" key to move to the next field, be aware that once the "Log It" button is enabled, the button becomes the default action for the "Enter" key.
So, for speed logging, one could do the following:

l Enable the Auto Date & Time option 
l Enable the Auto Freq & Band option 
l Enable the Auto-Fill log fields option 
l Enable the Auto Log option 
l Enter a callsign and click Enter to log with each new QSO. 

Next chapter: Tracking Sprint Statistics and SPC Details

Tracking Sprint Statistics and SPC Details
In most, if not all, SKCC sprint events, the basic sprint score is computed as the number of QSOs times the number of unique SPCs worked - the term SPC refers to State, Province, or Country. Each SPC is counted only once for the entire sprint.
Additional points are earned for contacts with Centurions, Tribunes, and Senators. These points are earned for each band on which theCenturions, Tribunes, and Senators are worked.
As you log QSOs during the sprint, SKCCLogger automatically keeps track of the key sprint statistics and displays those values in the lower right corner of its main window.
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The product of the SPC Count multiplied by the QSO Count plus the Centurion/Tribune/Senator point provides you with a basic score. Many sprints also include a special theme for which you can earn additional bonus points.
If you need to designate a specific bonus station callsign, add "special" bonus points, or adjust the points per band values you can click onthe underlined "Sprint Bonus" field's label to open this window.

The "Additional Bonus Points" field allows you to track any special bonus as you operate the sprint. This may be useful in sprint wherethere is a special one-time bonus for achieving some specific goal.
The "Bonus Station Callsign" field allows you to identify a specific callsign that has been designated as being worth extra bonus points for the sprint.
The lower half of the window allows you to adjust the default values that are generally associated with a sprint. Changing these values will stay in effect for the current and all future sprints until they are changed again.

Tracking SPC Multipliers
Some serious sprinters look to increase their sprint scores by accumulating SPC multipliers. Clicking on the underlined "SPC Count" field's label will open a special window that lists each US state, US possession, Canadian province, and Canadian territory, along with a checkbox indicating worked or not worked. SKCCLogger automatically checks off the boxes as you collect SPCs. Non-US/Canadian SPCs appear separately as a list at the bottom of the SPC window.
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Next section: Timing the Length of a QSO

Timing the Length of a QSO
In some cases it is useful to be able to track the the exact length of a QSO. The RagChew and Marathon awards, for example, require QSOs that last a minimum amount of time.
At anytime during a QSO, you can click on the underlined "Time:" label in the Log Entry Window to launch a QSO timer. By default, the timer uses the QSO Start Time shown in the Log Entry Window as the basis for computing the length of the QSO as compared to the current time.

The "Stop", "Pause", and "Reset" Push Buttons operate pretty much the same as you would expect on a Stop Watch.
Pressing "Stop" at the time the QSO ends, will freeze the total length of the QSO for you to record in the comments field or elsewhere.

Next section: Editing and Deleting Log Entries
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Editing and Deleting Log Entries
After you add an entry to the log, you may find you need to edit or delete the entry. The following subjects provide the details on how to do this:

l Editing a Log Entry
l Deleting a Log Entry

Editing a Log Entry
If you want to edit a single log entry displayed in SKCCLogger's main window, you have your choice of three ways to do it:

l Double click on the row containing the log entry; or, 
l Right click on the row and use a pop-up contextual menu; or, 
l Click on a row to highlight it, then click on the "Edit Row(s)" button above the List Box. 

If you want to edit two or more log entries as a batch, you will have to use the "Edit Row(s)" button. The following sections describes the Edit procedure for each method.

Right-Click, Contextual-Menu Method
Right clicking the mouse on a row in the log will cause a context-sensitive, floating menu to appear with three options: "Edit Row", "Delete Row", and "Save Selected As...".
Note: The "Save Selected As..." option is a shortcut to the File->Save Selected As..." function and provides a quick shortcut when youwant to save just one QSO entry to a log file.
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Selecting "Edit Row" will bring up the Log Edit Window with the selected row's data entered in the text fields.

Virtually all the options available to you when you first make a log entry are available when editing an entry.
The primary differences are that you no longer have an option for Auto-Date/Time, Auto-Freq/Band, Auto-Fill, or Auto-Log. Also, additional log entries with the same member will not be shown in the list box unless/until you hit the "Check Call" or "Check SKCC"button.
You may make any changes you desire, including changing the date, time, frequency, band, call, etc.
You can also check appropriate boxes to indicate whether or not a QSL has been sent and/or received.
When you are finished editing the entry, push the "Save Changes" button to save your changes.
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If you find that you don't need to make any changes, just press the "Cancel" button to close the window and cancel any changes made but not saved.

"Edit Row(s)" Button Method
The "Edit Row(s)" button (at the top of the log window) can be used to edit either a single log entry or multiple log entries as a batch. Begin by using mouse clicks to select all the rows in the main window's log that you want to edit (use mouse clicks in conjunction with CTRL or SHIFT keys). Then press the "Edit Row(s)" button (at the top of the log window).
If you have selected only one record to edit, processing will be identical to the process described for the right-click method described above.
If you have selected two or more rows, you will see a prompt summarizing the first row that you selected and providing you with options to either "Edit," "Skip," or "Quit Editing."

l Select "Edit" to open the log entry in the Log Edit window. 
l Select "Skip" to skip editing the displayed log entry. 

¡ This option provdes a quick way to select multiple records, yet skip a few in the process.
l Select "Quit Editing" to skip the current record and stop the entire process. 

The process described above will repeat for each log entry that you have selected to edit as a batch.

Next Chapter: Deleting a Log Entry

Deleting a Log Entry
If you want to delete a single log entry in the main window's list, you have your choice of two ways to do it:

l Right click on the row and use a pop-up contextual menu; or, 
l Click on the row to highlight it, then press the "Delete Row(s)" button above the log. 

If you want to delete two or more log entries as a batch, you will have to use the "Delete Row(s)" button. The following sections describes the delete procedure for each method.

Right-Click, Contextual-Menu Method
Right clicking the mouse on a row in the log will cause a context-sensitive, floating menu to appear with three options: "Edit Row", "Delete Row", and "Save Selected As...".
Note: The "Save Selected As..." option is a shortcut to the File->Save Selected As..." function and provides a quick shortcut when youwant to save just one QSO entry to a log file.
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Selecting "Delete Row" from the floating menu will bring up the "Delete Log Entry" dialog box.

The dialog box lists the date, time, call sign, and frequency of the selected log entry and requires that you confirm your request to delete the entry.
You have two options: "Delete" or "Cancel".

l Click "Delete" to delete the log entry. 
l Click "Cancel" to leave the log entry as is. 

"Delete Row(s)" Button Method
The "Delete Row(s)" button can be used to delete a single log entry or multiple log entries as a batch. Begin by using mouse clicks to select all the rows in the main window's log list that you want to delete. Then press the "Delete Row(s)" button.
If you have selected only one record for deletion, the processing will be identical to the right-click process described above.
If you have selected two or more rows, you will be provided with a prompt to confirm your request to delete multiple QSO records.
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l Select "Yes" confirm your request and delete all of the selected record.
l Select "No" to cancel the request and leave the selected records as is.

Next section: Managing Multiple Radios

Managing Multiple Radios
If you have more than one radio connected to your PC, you may want to have the SKCCLogger remember the specific settings for each one.
Setting up a separate configuration for each radio makes it simple and quick to switch between pre-configured radios with the SKCCLogger.
There are two basic steps involved in setting up and maintaining multiple radio configurations. The following topics in this section will help you create and maintain those configurations.

l Adding A New Radio Configuration
l Editing Current Radio Configuration

Adding A New Radio Configuration
To add a new Radio Configuration to the SKCCLogger, you must first open the "Radio Setup" window by selecting the "Configure Radio" option from the "Options" Menu in the main SKCCLogger window.
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If you have a radio currently connected with an open COM port, you must first close the COM port before adding or editing any radioconfigurations. Close the COM port by pressing the "Close Port" button on the Radio Setup window.
The following steps will create a new radio configuration:

l Click the "Config Name" pull-down selector and Select "New Config."

l Set the radio model, COM port, baud rate, parity, stop bits, CI-V port, and flow controls as necessary for the radio you are configuring. 
l Click the "Open Port" button to open the COM port. 
l The SKCCLogger will prompt you to provide a unique name for this specific configuration. You may use any name you wish, but each name must be unique -- and "New Config" is a reserved name.

l Enter a configuration name and press the "Save Name" button. 
At this point, the port should be open and you should see the Radio Setup window, with the configuration name and configuration parameters you selected. You should test the configuration and make sure everything works properly - ensure that you can read and set the radio's VFO.
If you need to make any changes to the setup, just make those changes within the Radio Setup window. The final setup that exists is the one that will be remembered and stored for next time.

Next chapter: Editing Current Radio Configurations
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Editing Current Radio Configurations
All radio configurations are edited from the "Radio Setup" window. If not already open, open the "Radio Setup" window by selecting the"Configure Radio" option from the "Options" menu in SKCCLogger's main window.

If you have a radio currently connected with an open COM port, you must first close the COM port before editing any configuration. Close the COM port by pressing the "Close Port" button on the "Radio Setup" window.
To open the Radio Configuration Edit window, click on the "Configuration Editor" menu and select "Edit Radio Configurations."

At this point, the "Edit Radio Configurations" window will open. The window will display the configuration name, radio model, and COM port for all radio configurations currently set up in the SKCCLogger.

All operations from this window are performed on the selected (highlighted) radio configuration item. If a row is not already selected, click on the row that you wish to modify.
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There are three basic operations you can perform on a Radio Configuration item:
l You can move an item up or down the list; 
l You can rename a configuration. Recall, however, that each configuration name must be unique, and "New Config" is a reserved name;
l You can delete a configuration from the list. 

The steps to complete each of these options is detailed below.
1. To reorder the list, just select the configuration that you want to move and click either the up or the down arrow next to the "Reorder Selected" label.2. To rename a configuration, just select (highlight) the configuration item and click the "Rename Selected" button.

The "ReName Radio Configuration" window will open with the current configuration name shown in the text field.

Enter the new name for the configuration and press the "Save Name" button. 3. To delete a radio configuration from the list, select the item and push the "Delete Selected" button.

A prompt will appear that asks you to confirm the deletion or cancel the request. 

Next section: ADIF Log Files
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ADIF Log Files
Even though the program requires that you open an ADIF log file before you starting logging QSOs, the actual QSO information is notstored in the ADIF log file.
The SKCCLogger maintains all of your log data in a SQL database on your PC's disk drive in a file named "LogFileDB.rsd." Whenever you save the log data to the ADIF log file, the data is copied from the SQL database to the ADIF log file.
Updates to the LogFileDB.rsd database file are made immediately as you enter them and the updates are committed to the database file after each change. Upon a normal shutdown of the program, the database contents are written out to the ADIF log file and the database file is deleted.
The following topics in this section will help you understand the relationship between the database file and the ADIF log file.

l Saving Log Data to an ADIF File
l Recovering From an Abnormal Shutdown

Saving Log Data to an ADIF File
Even though all of your log data are stored in an SQL Database file, an ADIF log file is created and written to the log subdirectory withinSKCClogger's main directory.
The log data are saved to the specified ADIF log file at the following times:

l When you select "Save Log Data" or "Save Log Data To..." from the "File" menu. 
l When you open or re-open a log file from the "File" menu. 
l When you select to start a new log file from the "File" menu. 
l When you press the "Save Log" button in either the "Log Entry" or "SKCCLogger" windows. 
l When you close the SKCCLogger.

Whenever changes have been made to the log database that have not been saved to the ADIF log file, a "Save Log" button will appear in both the "Log Entry" and "SKCCLogger" windows.

Next chapter: Recovering from an Abnormal Shutdown

Recovering From an Abnormal Shutdown
As mentioned previously, the SKCCLogger maintains your data in an SQL database on your PC's disk drive.
Updates to the database file are made immediately as you enter them and the updates are committed to the database file after each change. During a normal shutdown of the program, the database contents are written out to the ADIF log file and the database file is deleted.
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When you first open SKCCLogger, the program looks for the log database file in the SKCCLogger's home directory. If the database file exists, then the program knows that the SKCCLogger did not shutdown normally during it's previous run.
When an abnormal shutdown has been detected, you will be presented with a special message at startup telling you that the abnormal shutdown has been detected and giving you the option of either recovering the Last Log File or starting the SKCCLogger with no log file.

In MOST cases, you will want to recover the Last Log File. However, if you suspect that a corrupt log file caused the previous abnormalshutdown, then you may want to restart with No Log File. If you choose to start with No Log File, then you can re-open any previous log file, or use the "Restore From Backup Log" tool to attempt to recover the log file from the log database.
When you choose to recover the Last Log File, the SKCCLogger will create a temporary ADIF Log File from the current log database. You will be provided with an informational message regarding the recovered temporary log file.

Although your most recent logging data has been recovered, it is now in a temporary log file whose name is a SKCCLogger reserved file name.
You must save Recovered-Log.adi into SKCCLogger's "Logs" subdirectory with an appropriate new file name, using "Save Log As ..." in the main window's "File" menu.
If you continue to use the reserved "Recovered-Log" file, you will receive the following warning every time you open the log.
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Next section: Advanced Subjects: The Tools Menu

The Tools Menu
This section is dedicated to providing insight into some of the Tools and more advanced features of the logger.
The following subjects are included:

l Adding SKCC Numbers to the Log File
l Creating SKCC Award Applications
l Find - Text Search (Ctrl+F)
l Monthly Brag Submission
l Restoring From a Backup Log
l Resetting Saved Window Positions
l Setting a GMT Correction Factor

Adding SKCC Numbers to a Log File
The SKCCLogger provides a simple method for you to add SKCC Membership Numbers to your Log File.
If you have imported an ADIF Log File that was created by another logging program, then that log file will, most likely, NOT contain SKCC Numbers in a special field. In fact, the SKCC Field "Tag" was not added to the official ADIF Specification until ADIF Version3.0.3.
To add SKCC Membership Numbers to your current Log File, select the "Add SKCC Numbers to Log" option from the Tools Menu.

Please note the following information regarding adding SKCC Membership Numbers to an open log file:
l The processing will affect, and may modify, the SKCC Field in EVERY QSO in the log file. 
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l The SKCC Number for each log entry will be set to a blank for non members or to the SKCC Number and appropriate C, T, or S suffix for SKCC members. 
l The processing is as follows for each QSO record in the log: 

¡ If the QSO Mode is not "CW", then the SKCC Field is set to Blank; Otherwise, 
¡ Search the Membership Database for a Matching Current, Past, or Alternate Callsign. 
¡ If a membership record is not found, set the SKCC Field to Blank; Otherwise:

n Use the SKCC Number associated with the callsign. 
n Affix a C, T, or S suffix based on the QSO Date. 

l There is no implication that the QSO was a legitimate SKCC member-to-member QSO that can be used for SKCC credit: 
¡ You MAY not have exchanged required information during the QSO. 
¡ You MAY not have been using an approved CW keying device. 

l This tool is provided for your convenience ONLY.
Selecting "Add SKCC Numbers to Log" from the Tools Menu will result in a dialog window outlining some of the listed caveats and requesting that you confirm your request.

Press "Start" to begin the processing or "Cancel" to close the window and do nothing.
The processing required to complete this action requires the program's full attention. You will be locked out from performing any otheraction until the processing completes and the processing, once started, cannot be interrupted.
A progress bar will be displayed so that you can watch the progress of the processing. Depending on the size of your log file and the speed of your processor, the complete processing can take anywhere from a few seconds to several minutes.
When the processing is completed, a message window will display showing the total number of records that were changed.

Next section: Creating SKCC Award Applications

Creating SKCC Award Applications
The SKCCLogger can assist you in preparing text files that can be submitted to the SKCC Award Administrators. Working from an ADIF Log File, the program will analyze the log contents and generate award applications for you.
Note: The Award processor will process an ADIF log file created by any logging program that conforms to the ADIF standards. The logfile processed does not have to be a log file created by the SKCCLogger.
As with all things involving computers, the old adage of "Garbage In - Garbage Out" applies to this processing. The program will 
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ASSUME that each QSO with an SKCC member in the log was a valid SKCC QSO completed using approved keying devices and included an exchange of membership information.
The program will generate award application forms for you, but YOU are responsible for ensuring that the information contained in the application is a true and accurate representation of your operating activities. In addition, once the application text file is created, you are required to submit it to the appropriate award administrator for processing.
The processing requires that you identify a single ADIF Log File that contains ALL the QSOs that should be considered for the type of Award Application being generated. Before, starting the award creation process you should prepare a log file using the SKCCLogger or some other logging program to create a single ADIF log file to be processed.
Once you have created an ADIF Log File to be examined, you launch the award processing by selecting the "Create Award Applications" option from the "Tools" Menu.

The SKCCLogger Installation process installed a Membership Data File that was current at the time the Program was released. You should download a up-to-date membership data file.
The first time you run the Award Processor, you will need to identify yourself, update your current award status, and point the processor to your ADIF log files. You will see the following page.
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Start by downloading a local copy of the membership data file - Just press the "Refresh" Push button to access the website and start thedownload.
After the membership data has been downloaded, you will need to enter your callsign and press the "Refresh My Info" Push Button to fill in the remaining test fields with information about your membership. You can edit your Name, QTH, and SPC to reflect what you want to have on the Award Application.
The SKCC Membership data list maintains only your first name that you used when you applied for membership. Most award administrators prefer to know the name that you use on the air as well as your last name as it makes for a better award announcement when posted to the group.
Note:

l Anytime you have earned a new award level, such as Centurion, Tribune, Tribune x8, or Senator you MUST click on "Refresh My Info" so the the award Processor can save your updated information. 
l When an award level, such as Centurion, Tribune, etc. are reflected in the downloaded data file, the date of the award will be displayed in the appropriate text field and you will not be able to edit the information. 

Once your membership data has been entered, press the "Save & Continue" Push Button to proceed to identifying the ADIF Log File to be used.
You will need to press the "New Log File" to select your ADIF Log file for processing.
Once you have selected your ADIF Log file for award processing, the program will start some very intense number crunching that can be very time copnsuming - especially for a log with several thousand log entries. You MAY even get a "Program is not Responding" message from your operating system. But, don't panic - the program is just busy analyzing the log file.
Once the processing has completed, the window should look similar to this:
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The next time you access the Award Processor Setup Page, the program will remember your settings. You might want to download a fresh copy of the membership data file and select a new file if there have been changes or additions to your log file.
Press the "Create Applications" Push Button to access the award Application Selection Window.

As of the current version of the SKCCLogger, the following SKCC Awards programs are suppported:
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l Centurion / Tribune / Senator Award
l Worked All States / Worked All States - Centurions 
l DXQ / DXC Awards
l Prefix Award 
l QRPx1 / QRPx2 Awards 

Additional Award processing may be added in future versions if the users find the feature useful.
Pressing the "Centurion/Tribune/Senator" Push Button will tell the program to analyze your log file for these awards and will present you with a summary page showing your status of these awards on each band.
You can study the numbers presented to see how close you are to various award levels and select the specific award applications to be created. Make your selections by clicking the appropriate checkboxes and then click the "Create Applications" Push Button. The program will provide processing status in the far right hand "Processing Status" window.

After the processing is completed and the selected award applications have been created, you will be provided with an information window prompting you to choose your next action. You can either continue to create more applications of the same award type or return to the Award Application Selection window.
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Selecting the "Create Some More" option will simply close the information window and leave the current Award Status window for you to select and create additional award applications of the same type.
Selecting the "I'm All Done" option will close both the information window and the current Award Status window and return you to the Award Application Selection Window.

From this point you can either select another award type to analyze or open the Award Application Folder to access the applications you have created. If you select the "Open Application Folder" option, the prgram will open a Folder dialog Window for you.
Using the Application Award Folder dialog Window you can complete Virtually ANY file processing that you might want. You Can:

l Double-Click an application to open it with Windows Notepad.
l Drag and drop an application to your desktop or anotheer folder.
l Delete old applications that you no longer need.

Note: It is YOUR responsibility to maintain the contents of the AwardApplications folder. Keep all you want or delete them all - it is entirely up to you.

Other Supported Award Types
The SKCC WAS/WASC and DXQ/DXC award processing is similar to the Centurion, Tribune, and Senator Award processing. Additional documentation for those awards is not necessary.
The SKCC Prefix award processing is essentially similar to the Centurion, Tribune, and Senator processing. The numbers presented in the summary window are the total point values earned per band.
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Please note the following regarding QRPx1 and QRPx2 Award Application Processing:
l The Award Processor uses the values logged in the TX Power and RX Power fields to find QSO that are eligible for QRP Awards. 
l Even though the the processor can create band-specific QRP Awards, the SKCC QRP AWard does not currently provide for band-specific endorsements. 
l The numbers displayed in the QRP Award Status Window are the total points computed for that specific band. 

Next section: Find - Text Search (Ctrl+F)

Find - Text Search (Ctrl+F)
The tool menu item "Find - Text Search" (also activated with Ctrl+F) provides a quick method to search for text within the current loglisting.
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This option will open the Text Search Window. You enter the text to be searched in the "Search For" text field, select the fields to be searched, and then press either "Find Next" or "Find Previous".

Notes:
l The text search is not case sensitive - "ac2c" will match "AC2C". 
l When the specified text is found, the row containing the text will be highlighted. 
l The column does not have to be displayed for the text to be found. 
l When first activated, the current search row is the top row. 

¡ When searching downward (Find Next), reaching the end of the list will reset the row pointer to the top row.
¡ When searching upward (Find Previous), reaching the top of the list will reset the row pointer to the bottom row. 

l Changing the Search Text will reset the row pointer to the top row. 

Next section: Monthly Brag Report

Monthly Brag Report
As described on the SKCC Group Web Page, the Monthly Brag activity began in April 2010 as a way to encourage contacts among SKCC members independent of sprints, contests, or special events.
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The idea is to see how many unique SKCC numbers you can accumulate during any given month. Your count starts fresh each month. You may contact the same members from one month to the next, but you can only count a member once during a month - no dupes, no multiple-band contacts with the same member.
If you want to participate in it, the SKCCLogger provides a simple method for you to determine your input for ther "Monthly Brag".
To start the Brag Report preocessor select the "Monthly Brag Report" option from the Tools Menu.

When first opened, the Brag Report Processor Assumes that you will be generating a Brag Report for the previous month. The processor will automatically compute and fill in the dates for the Monthly Euro Sprint (SKS-E), Weekend Sprint (WES), and Weekday Sprint (SKS). If you did not participate in those events and had Brag QSOs during the events, you can just clear those fields.
The Brag Report Processor also provides you with the ability to excludes up to three additional periods from your Monthly Brag Count.

The expected date format depends on the International settings defined on your PC ("MM/DD/YYYY" for USA) and the time format is "HH:MM:SSZ".
Please note the following:

l The processor checks for proper format after each field is entered. 
l Error checking for an event is performed after the End Time is specified. 
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l You may leave the Start and End periods completely blank, but MUST complete all four entries for an event to be excluded.
After you have entered the events to be excluded from the count, press the "Get Brag Count" to get the Monthly Brag Count and a summary of how the count was determined.

Next section: Restoring From a Backup File

Restoring From a Backup Log
The SKCCLogger has many features designed to prevent the accidental loss of logbook data. These features include the detection of an abnormal shutdown and the saving of all log transactions in an SQL database file on your hard drive.
Starting with Version v01.01.01, the SKCCLogger provides you with the ability to restore from (or roll back to) a previous version of thelog. In order to safely use and get the most benefit from this option, please take a few minutes to read and understand just how the logger works and how this capability is provided to you.
As you use the SKCCLogger to log your SKCC QSOs, the logger keeps track of your actions as follows:

l Every time that you add, edit, or delete a log entry, the change is saved into the log's SQL database file. This database file ("LogFileDB.rsd") resides in the SKCCLogger's application directory (C:/SKCCLogger if you followed the installation defaults). 
l Additionally, every time you open a new ADIF log file or save changes to the current ADIF file, the program also saves a copy of the log database file. 
l Every time the program saves an update to "LogFileDB.rsd," the program automatically saves a copy of the updated file in a special Backup subdirectory (e.g. C:\SKCCLogger\Backups). 
l Each backup file is uniquely named by appending the current Date and Time to the name of the ADIF log file you are currently using. 
l For example, if your current Log file is "AC2C-WES-Jan-2013" then a backup file for that log might be named "AC2C-WES-Jan-2013 on 2013-01-13 at 12.34.56Z". 
l The program currently keeps up to 50 backup database files in the Backup subdirectory. When a backup file is created, the program checks to see how many backup files exist in the directory and starts deleting the oldest files until the total returns to 50.
l Although 50 backup files may seem like a lot, it really does not take long to accumulate 50 backup files. While the primary purpose of this capability is to recover a log in the event of a catastrophic event or operator error, this option may also be used to roll back your log to a previous state. 

Now, with all the above in mind, let's see how to restore your log from a backup database file.
Note: You should save any current changes to your current log file before continuing.
Select the "Recover From Backup" option from the Tools menu on SKCCLogger's main window.
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Selecting the "Recover From Backup" option will result in a "File Open" dialog window that will display the current contents of the Backup subdirectory.
Use whatever standard sort/view options you want to look through the various backup files. If you are looking for a specific name, thenyou may want to sort by filename. However, if you are looking for a specific time, then you may want to sort on creation date.
Once you have found the backup file you want to use, select the file and click the "Open" button to load the data in the backup file or click "Cancel" to cancel the restore process.
When you select to restore from a backup, the program uses the data in the backup file to create a temporary log file with a special name of "Recovered-Log" and saves the log file in the application's main directory (e.g. C:\SKCCLogger). You will see the following warningdisplayed:

Press "OK" to continue. You can now review the contents of the recover log and make sure it is the one you want. If not, just start over and open a different backup file.
Once you have recovered the file that you wanted, you MUST save the log file in your Logs subirectory with an appropriate file name.
If you continue to use the reserved "Recovered-Log" file, you will receive the warning every time you open the log.

Next section: Resetting Window Positions
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Resetting Saved Window Positions
The SKCCLogger provides a user-selectable option to save and recall the position and size of the various windows the program uses. For the most part, those options provide adequate day-to-day control of where on your screen the various windows appear.
There are, however, at least two situations where the basic logic of the processing might fall apart:

l A user may have two or more monitors and has windows displayed on a monitor other the main monitor. If that user removes orreconfigures the additional monitors, then a window may try to restore itself to a screen position that no longer exists. 
l A user may adjust the screen resolution of a monitor at any time. If the new resolution setting has fewer pixels that the last setting, a window may try to restore itself to a screen position that no longer exists. 

If you ever get into a situation where you are trying to open a window and the window just will not display, then you may reset the position of all program windows through the Tools Menu.
Note: Only positions of fully closed (not minimized) windows can be reset. You may not see a window, but it may still appear on the Windows desktop's task bar. You can close applications from the task bar.

Selecting "Reset Window Positions" will result in a dialog window asking you to confirm your request.

Press either "OK" to complete the action or "Cancel" to close the window and do nothing.

Next chapter: Setting a GMT Correction Factor
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Setting a GMT Correction Factor
On most Windows PCs, the user sets the local time and also tells the Windows Operating System (OS) the local time zone. Those two items together allow the PC to know the time difference between the Local time and GMT. The SKCCLogger program relies on the time difference information provided by the Windows OS to convert local time to GMT for logging purposes.
If, for whatever reason, you are unable to get the SKCCLogger to log correct GMT dates and times, you can specify a special offset value to be used in computing GMT from your PC time setting.
Select "Set GMT Correction Factor" from the Tools Menu.

This option will open the Set GMT Correction Factor Window. The window displays the current correction factor along with the current local PC Time and the current GMT Time computed using the correction factor.
The window shown indicates an offset of 0.0 that results in GMT being five hours ahead of local time - My PC is in the USA Eastern Time Zone.

To change the correction factor and test the GMT time resulting from the new correction factor, enter a number in the "Correction" field and press the "Test It" button to see the GMT time resulting from your correction factor.
When you find a correction factor that gives you the correct GMT time, press the "Save" button to set and remember the correction factor you have specified.
Next section: Appendices
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Appendices
The following Appendices provide specialized information of interest to some users.

l Running Multiple Copies Simultaneously
l Note to Linux Users
l Revision History
l To Do List and Known Bugs

Running Multiple Copies Simultaneously
Some users have requested the ability to run two or more copies of the SKCCLogger simultaneously.
Running multiple copies of the program allows for some advantages, but also has some risks.

Advantages:
¡ Ability to have two or more log files open simultaneously; 
¡ Ability to control two or more radios simultaneously; 
¡ Ability to check for QSOs in one log while logging into another log. 

Risks:
¡ You might inadvertently be making changes to the same log file. In this case, each copy of the program is keeping it's own database file and the last program to save it's copy of the log. will replace the copy saved by the other copies. 
¡ With multiple versions running simultaneously, there is a risk that you might lose track of which log you are modifying at any one time. 

With these advantages and risks in mind, the SKCCLogger program has been developed to allow the simultaneous operation of multiple copies of the program. However, there are some restrictions.

Run multiple copies of the SKCCLogger with extreme caution and at your own risk.
If you have installed a single copy of the SKCCLogger into a single folder/directory on your PC, an attempt to launch the program while a current copy is running will result in the following warning window.
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As soon as you click the "OK" button, the newly launched program will immediately shutdown.
As described in the warning, IF you want to operate multiple copies of the program, then you must install multiple copies of the program into separate folders. Additionally, each separate folder MUST be uniquely named.
You can create multiple installation copies of the SKCCLogger in one of two ways - pick whichever you feel most comfortable with:

l Run the SKCCLogger Setup program and override the defaults to specify your own directory/folder; or, 
l Copy the contents of your current SKCCLogger directory/folder to a new folder that you have created and renamed.

As long as you keep your folders and log files separate theye should be no issues or problems with running multiple copies of the SKCCLogger. If you venture into having the same log file from the same folder/directory open in two or more instances of the logger, be extremely careful about making changes to te log file. As stated above, if two or more programs have the same log file in the same folder/directory open and make changes, then the last program to save the log will replace the log saved by other programs.
Run multiple copies of the SKCCLogger with extreme caution and at your own risk.

Next section: Note to Linux Users

Note to Linux Users
This program has been successfully tested with Linux (Ubuntu 11.10 and higher) via Wine. To install SKCCLogger, make sure you have the latest version of Wine installed, as well as the latest version of Hamlib. These should be available through your Linux distribution's software repositories. Then follow these steps:

l After you download SKCCLogger, use a terminal to move into the directory containing the program's zipped file, using the cdcommand. At the system prompt, use the unzip command to release the files in SKCCLogger_Setup.zip.
l At the system prompt, type ls and you should see a file named SKCCLogger_Setup.exe. At the prompt, type chmod a+x SKCCLogger_Setup.exe to set the file up as an executable file in Linux. 
l At the prompt, type ./SKCCLogger_Setup.exe. Wine will automatically activate and begin the installation process. Just follow SKCCLogger's setup steps as the program presents them and allow the installer to open the program at the end of the process so you can configure the program.

During configuration, you'll have to take a few extra steps if you want have SKCCLogger read and control your radio's VFO-A. 
Specifically, you will need to choose the COM port in your Linux /dev directory that you want to attach to one of the COM ports in SKCCLogger, found under Options --> Radio Setup on the main window's menu bar. To do this for a USB-to-serial connection, for example, you will need to set up a symbolic link in Wine's dosdevices folder to /dev/ttyUSB0. The symbolic link will have a name like COM1, but it will point the program to the USB port, the true connection point between the computer and the radio.
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To make sure the radio and program play nicely together, perform the following steps:
l Open a terminal and at the system prompt type:>cd home/~/.wine/dosdevices (where ~ is your user directory)
l Press the Enter key.
l At the terminal's system prompt, type:>sudo ln -s /dev/ttyUSB0 COM1

(Note: COM1 in this instance is an example. You can specify any of the com ports the SKCCLogger offers.)
l Press Enter again, enter your password, then press Enter again.
l When the system prompt returns to the screen, type ls, press Enter, and you should see something like this among the listed disc drives: COM1@, or just COM1.

You now can proceed with the rest of the setup process under Options --> Radio Setup.

Next section: Revision History

Revision History
The SKCCLogger has undergone several revisions since its initial release in May 2012. The following list tracks the changes made in each release. Revisions are presented from most recent to earliest.
v03.00.04 Beta, 2015-11-11:

l Bug Fixes: 
¡ Monthly Brag Report now counts QSOs on WARC Bands during sprint periods. 
¡ Fixed "Award Processor" and "Add SKCC Numbers to Log" processing to handle cases of members having the same Callsign, but at different times. This change also handles cases where a current member has the call of a member that is nowSK. 
¡ Modified Prefix Award processing to use new "GetSKCCFromCall" function. 

l Changes to previous processing methods:
¡ Removed code that forced Name and City to 'TitleCase' in the Add Log Entry and Log Edit windows. 
¡ Monthly Brag Report now auto-fills dates and times for SKS-E, WES, and SKS based on Brag Month & Year entered.
¡ Download Membership processing now auto-starts the download when the window opens. 
¡ Made manual time entry in Log Entry and Log Edit easier. Fields now accept HHMM[Z], HH:MM[Z], HHMMSS[Z], and HH:MM:SS[Z] formats.
¡ Text Search (Ctrl+F) Window now defaults to search BOTH Call and SKCC Fields. 

l New Capabilities & Features: 
¡ Added "My Gridsquare" to Program Options and ADIF Log File. 
¡ Added Kenwood TS-440 to Radio List. 
¡ Added Icom IC-7400 to Radio List. 
¡ Added JT9 to the Mode selection list. 

l Changes to how the program works - not "seen" or necessarily noticed by the user: 
¡ Changed Log Entry Window Close Caution to a Dialog Box with the default action of "Don't Close".
¡ Major rewrite of the Load ADIF Log File method using RegEx to extract all Tags. 
¡ Major rewrite of the Award Processor Load ADIF Log File method using RegEx to extract all Tags. 

v03.00.03, 2015-07-21:
l Bug Fixes: 

¡ Fixed a bug related to listing matching callsigns that conmtain a slant character in the Add Log Entry window. 
¡ Fixed a bug in the award processor where a previously processed log file that was on a drive that no longer exists would 
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cause a Nil Object Exception. 
l Changes to previous processing methods:

¡ Changed processing for Prefix awards. Processing now skips all slant (/) characters and uses the station license callsign only. 
l New Capabilities & Features: 

¡ Added Text Search (Ctrl+F) Capability in the Main Log window. 
¡ Changed Prefix Award Processing 
¡ Changed membership download processing to avoid partial download 
¡ Added Icom IC-7410 to Radio List 
¡ Added Icom IC-7850/7851 to Radio List 
¡ Added Kenwood TS-990S to Radio List 
¡ Added Yaesu FT-747GX to Radio List
¡ Added Yaesu FT-757GXII to Radio List 
¡ Added Yaesu FT-847 to Radio List 
¡ Added Yaesu FT-991 to Radio List 
¡ Changed Kenwood TS-480HX to just TS-480 for TS-480HX or TS-480SAT 

l Changes to how the program works - not "seen" or necessarily noticed by the user: 
¡ The membership files are updated on the server every 2 hours. There is a very small window where a membership download could occur during the update and result in a partial membership listing being downloaded. The download processing now looks for AT LEAST the same number of members as the previous list and will attempt five download attempt, if necessary. 
¡ Build Date and Time now displays in Eastern Time instead of Zulu. 
¡ Removed code that would Look for a membership text file that is newer than the Membership database file. The capability was initially added to allow a user to download the membership data file and copy it to the application folder. The capability is no longer needed. 
¡ Added code to membership download processing to avoid a small window where a partial file is download while it is beiong created on the server. 

v03.00.02, 2015-02-26:
l Bug Fixes: 

¡ Previous versions could give extra Sprint QSO Counts if a callsign was logged in two different ways - e.g. AC2C and AC2C/QRP. Added new processing to avoid this error.
l Changes to previous processing methods: 

¡ The method used to count QSOs in a sprint was modified as noted above. 
l New Capabilities & Features: 

¡ Add/Edit log Entry now supports additional Digital modes: JT65, JT65A, OLIVIA, and SSTV. 
¡ The Award Processor will now provide a warning if the log file has been modified since the last time it was processed. Some users were forgetting to reprocess the log file after making additional log entries. 

l Changes to how the program works - not "seen" or necessarily noticed by the user: 
¡ The Award Processor now displays file and database dates and times in Zulu rather than local time. 
¡ If you have set your Callsign in the Program Options window, the program will automaticaaly update your SKCC Number when you download the membership information. Thus, your C, T, or S suffix will be automatically updated for you. 
¡ The Award Processor now displays the Database Update Date/Time in Zulu time. 
¡ Award Processor modified to list callsigns ONLY as listed in the membership database - eliminating unrecogniozed prefixes or suffixes. 

v03.00.01, 2014-11-29:
l Bug Fixes: 

¡ Fixed a minor error introduced in v03.00.00 that would only update the C/T/S/Tx8 info in the Award Processor if it was non-blank. 
l Changes to previous processing methods: 

¡ None. 
l New Capabilities & Features: 

¡ Added support for additional Centurion and Tribune Award/Endorsement Levels. 
l Changes to how the program works - not "seen" or necessarily noticed by the user: 

¡ None. 

v03.00.00, 2014-09-12: (Major Upgrade Release)
Note:This is a Major Upgrade Release due to the number of changes required to merge logging and award processing to utilize the same membership database file.

l Bug Fixes: 
¡ A user in the Netherlands discovered a problem with Internationmal compatibility. Fixes were made to allow for alternate 
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decimal separators while adhering to the ADIF spec that requires a period (.) decimal separator. 
¡ One user reported a problem with the award processor that was caused by a corrupted Award Processor Log Database File.We were unable to determine how the file was corrupted. However, the processing now detects a corrupted database file, deletes it, and notifies the user that the log needs to be re-processed. 

l Changes to previous processing methods: 
¡ The logger now uses a single membership data file for both logging and award processing. 

l New Capabilities & Features: 
¡ Added support for Icom IC-735 Radio with a 4-Byte Frequency data packet. 
¡ Added supoport for Icom IC-7100 Radio. 

l Changes to how the program works - not "seen" or necessarily noticed by the user: 
¡ None. 

v02.00.08, 2014-07-01:
l Bug Fixes: 

¡ One user noticed that (US) State ADIF tags in lowercase were being considered unique from the same State in uppercase. Code was added to the Award Processor to consider ALL States ADIF Tags as Uppercase. 
¡ It was discovered that current processing would allow a log entry dated in the future. Code was added to check for future dates in the Log Entry and Log Edit windows. 
¡ "DC" now counts as "MD" for WAS and WAS-C Awards. 

l Changes to previous processing methods: 
¡ The award Processor no longer changes the case of the member's Last name. 

l New Capabilities & Features:
¡ The Award Processor now provides a notice of the Membership Data File is over four days old. 
¡ Added support for Yaesu FT-1000 radios.

l Changes to how the program works - not "seen" or necessarily noticed by the user: 
¡ None. 

v02.00.07, 2014-05-01:
l Bug Fixes: 

¡ None. 
l Changes to previous processing methods: 

¡ The Previous QSOs listing in the Add Log Entry & Edit Log Entry Windows now include QSOs logged with alternate or past callsigns used by the member. 
¡ The "Add SKCC Numbers to Log" Tool has been rewritten. It now assigns SKCC Numbers and appropriate C, T, or S suffix based on the date of the QSO compared to the Membership, Centurion, Tribune, and Senator Award dates contained in thew Membership Records. 
¡ The "Monthly Brag Report" Tool has been rewritten. The processing now allows you to specify the Start date/time and the End Date/time for the SKS-E, WES, SKS, and up to three additional special events to be excluded. The processing also gives a summary report of how the Breag Count was calculated. 

l New Capabilities & Features:
¡ Added support for QSL Sent/Received Status. 
¡ The user can now double click on a "Previous QSO" listed in the Add Log Entry Window to open the listed QSO in the Log Edit Window. 
¡ The Award Processor now allows the user to manually enter their Centurion, Tribune, Tx8, or Senator Date if (and only if) the dates are blank in the downloaded membership information file. This allows a member to update their status immediately upon award and before the online database is updated. 

l Changes to how the program works - not "seen" or necessarily noticed by the user: 
¡ The "Previous QSO's" listing in the Add and Edit Log Entry windows now display SKCC Number instead of Frequency. 
¡ The Award Processor now automatically executes a "Refresh My Info" operation whenever the Membership Database isUpdated. Some users were skipping this step and this change automatically executes for them. 
¡ The date formats displayed in the Award Processor were changed to be compatible with other date formats used throughout the Logger. 
¡ The rig interface for the Yaesu FT-990 was tweaked to allow any response of at least 16 Bytes. 

v02.00.06, 2014-03-23:
l Bug Fixes: 

¡ Fixed a couple bugs in the Program Options Window: 
n When setting your Callsign, the program would not recognize the setting UNLESS the User hit TAB or ENTER. This has been fixed. 
n Pressing "Cancel" from the Program Options Window effectively only just closed the window - any changes you made were effective. Now the current settings are saved when the window is opened and are restored to initial values when 
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the "Cancel" button is pressed.
¡ Actually, more of an enhancement... When an ADIF Log is loaded that does not have BAND information, the Band is computed using the frequency information. 

l Changes to previous processing methods:
¡ "Sprint Logging" Mode no longer requires RX Power to be logged for non-members. 

l New Capabilities & Features: 
¡ Added Processing for QRPx1 and QRPx2 Awards. 
¡ Added option for User-Selectable Fonts for use in Text Fields. 
¡ Added interface for Icom IC-718 Radio.

l Changes to how the program works - not "seen" or necessarily noticed by the user: 
¡ The Recent QSOs listed in the Log Entry Window are now displayed with the most recent log entries at the top. 
¡ Added the capability to provide URL updates during the membership download process.

v02.00.05, 2014-03-01:
l Bug Fixes: 

¡ Fixed two bugs in DXQ Award Processing: 
n Previous processing allowed one contact from your home Country. 
n Previous processing included QSOs from other bands even when a single band was specified. 

l Changes to previous processing methods: 
¡ The DXQ and DXC Award Applications now list the DX Entity Name rather than the DXCC Code.. 

l New Capabilities & Features: 
¡ Added support for Ten-Tec Argonaut VI and Ten-Tec Eagle. 
¡ Added support for Yaesu FTDX-1200 and Yaesu FTDX-3000. 
¡ The program now checks for new Upgrades everytime the Membership Data File is downloaded. 

l Changes to how the program works - not "seen" or necessarily noticed by the user: 
¡ Added a "Next Step Guide" informational window to the Award Application Creation processing to inform the user of the options available after the selected applications have been created. 

v02.00.04, 2014-02-12:
l Changes to previous processing methods:

¡ Changed processing of Multiple Row Editing. Fixed an unexpected rearrangment of entries in the Log Listing when the user has sorted the list on a certain column or changed information that would cause it to list in a different order before and after editing. 
¡ The program now remembers and makes "sticky" any column sort options selected in the Main Log List Box.

l New Capabilities & Features: 
¡ Added an optional "GMT Correction Factor" for users whose PCs were not reporting GMT Date and Time correctly. 

l Changes to how the program works - not "seen" or necessarily noticed by the user: 
¡ Removed a check for correct field count in the downloaded membership list. This change is in preparation for a planned change to the data file format. 

v02.00.03A, 2013-12-02:
l Bug Fixes: 

¡ Fixed an error in the WAS Award Processing routine that would cause a NilObjectException error when a callsign contained a slash (/). 

v02.00.03, 2013-12-01:
l Bug Fixes: 

¡ Fixed an error in the Award Processing routine that would occur with some International Date settings. 
l Changes to previous processing methods:

¡ Added DXCC code field to the Add Log Entry and Log Edit Windows.
¡ The Add Log Entry window (optionally) auto-fills the DXCC Country Code, if it is contained in the current SKCCDATA file. 

l New Capabilities & Features: 
¡ The User can optionally have their Callsign and SKCC Number displayed in the Title of the Add Log Entry Window.
¡ Added DXQ and DXC Award Processing. 
¡ Added a Monthly Brag Report option to the Tools Menu. 

l Changes to how the program works - not "seen" or necessarily noticed by the user: 
¡ The installation program now installs a local copy of the SKCCDATA data information during installation. This is the data file used for award processing and is also used to obtain a member's DXCC Country code. 
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¡ The Award Applications Folder Listing Window now allows Multiple File selections. This allows the user to Select and Move or Delete multiple application files. 
¡ The processing that backs up the current log database file has been converted to run as a background (thread) process. This change makes the log entry process a bit faster - especially when working with larger log files.

v02.00.02, 2013-11-01:
l New Capabilities & Features:

¡ Added the capability to run multiple copies of the SKCCLogger program simultaneously. 
¡ Added WAS and WAS-C Award Processing.

l Changes to how the program works - not "seen" or necessarily noticed by the user: 
¡ Changes made to handle a changed format of the downloaded Membership Data file used by the Award Processor.

v02.00.01, 2013-10-19:
l Bug Fixes: 

¡ Fixed a bug in the Senator award application processing that had the effect to ignore the requirement to be a Tx8. 
¡ The "Add SKCC Numbers to Log" processing had an error working with callsigns that were imported in lowercase. The processing has been fixed to handle callsigns in lowercase. 

l Changes to previous processing methods: 
¡ The "Save File" buttons in the Main Logger window and in the Add Log Entry window now remain visible at all times. Thebuttons are enabled or disabled as appropriate depending on whether or not changes have been made since the last file save operation. 
¡ A QSY request by button press, Tab, or Enter key now ignores a blank frequency entry.
¡ A Tab or Enter key exit from the QSY Text field now changes focus to the Callsign Text field after the QSY is processed. 

l New Capabilities & Features: 
¡ The "Sprint Bonus" processing has been changed:

n The user can now specify a "Bonus Station" Callsign for a sprint.
n The user can also specify a manual/extra bonus point value. 
n The user can edit the per band bonus point values assigned for a Centurion/Tribune/Senator or Bonus Station. 

¡ The Icom IC-765 has been added as a supported radio model. 
l Changes to how the program works - not "seen" or necessarily noticed by the user: 

¡ A "Save selected as..." operation no longer adds the saved filename to the Recent Log List. 
¡ The Log Entry window has been renamed as the "Add Log Entry" window. 
¡ Some window layouts have been changed slightly to accommodate users that have selected to use a 125% font size in theirscreens. 

v02.00.00, 2013-09-14:
l Bug Fixes: 

¡ Fixed a bug in the Add SKCC Numbers to Log processing that would not detect a "Null" field value.
l Changes to previous processing methods: 

¡ During Program Starup, the message that used to advise that the local membership data was older than a specified age now provides an option to download current data immediately. You may also skip the download and complete it manually at alater time. 
¡ Additional logging modes (PSK31, HELL, and RTTY) have been added. 

l New Capabilities & Features: 
¡ Added a QSO Timer. Click on the QSO Time label in Log Entry Window. 
¡ Added a counter to the Add SKCC Numbers processing to tell the user how many numbers were added. 
¡ Added basic SKCC Award Application Processing. Current capabilities provide for Centurion, Tribune, Senator, and Prefix Awards.

v01.01.04, 2013-08-03:
l Bug Fixes: 

¡ Added code to handle a connected radio that stops responding to VFO Read requests. 
¡ Sprint Bonus was (sometimes) being lost during an ADIF Merge function. Added code to try to fix it. 

l Changes to previous processing methods:
¡ Made a minor change the Log Entry Window, QSY Field Mouse Wheel Scroll processing. Now, the mouse wheel scroll will change the frequency ONLY if the QSY Field has been selected and has the current "focus" of the program. 
¡ Created a separate window to handle downloading of SKCC Membership Data. This window is now available from three different places in the program. 

l New Capabilities & Features: 
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¡ Added processing to handle the new Senator level. 
¡ Membership Data Download can now be accomplished from three different places in the program: 

n By clicking the mouse on the "Members in DB" label in the lower left region of the Main window. 
n By selecting "Update Membership Data" from the "Options" menu. 
n By clicking on the "Update Membership Data" Push Button in the Program Options Window. 

l Changes to how the program works - not "seen" or necessarily noticed by the user:
¡ Log and membership databases were converted to SQLiteDatabase Class objects. 

v01.01.03, 2013-07-06:
l Changes to previous processing methods:

¡ Changed Log Entry window to set focus to Callsign field after Log Entry even when entering manual Date/Time/Freq/Band. 
¡ Log Entry Window "Clear All" function now sets focus to Callsign field even when entering manual Date/Time/Freq/Band. 
¡ Moved the Log Entry Window "Clear All" button to the lower left corner of the window to make it less likely to be hit inadvertently. 
¡ The application has been changed to consistently display dates in a standard format as defined by the user's InternationalFormats setting for their PC. 

l New Capabilities & Features:
¡ None. 

l Changes to how the program works - not "seen" or necessarily noticed by the user: 
¡ The application's Version number is no longer displayed in the Main Window Title Bar. The current Version and Build information is always avalable from the Help -> About menu option.
¡ Loading of an ADIF Log no longer checks for duplicate entries. Duplicate log entries are checked and skipped ONLY during a file Merge operation.
¡ The SKCCLogger Application has been created using a development system previously known as "Real Studio". Recently, the company changed their Application development system to "Xojo". Although it is hoped that the impacts of the change are minor, there will be some changes required to implement a new databse system. These changes should not be noticed by the user. 

v01.01.02, 2013-04-20:
l Bug Fixes: 

¡ Changed the processing used to refill the Log List Box whenever the Main Window is resized. The previous processing would occassionally cause the program to hang if the user moved the window while the program was loading an extra large log file.
l Changes to previous processing methods: 

¡ Duplicate QSOs with the same member on the same band are no longer counted in the QSO Count for computing Sprint Score. These QSOs were previously counted to allow for the past process of splitting 40M into two bands - above/below 7100 KHz.
¡ Callsigns that contain a slant ("/") are now treated differently.

n The callsign is first treated exactly as entered and is searched for within the membership database. 
n If no match of the entered callsign is found, then each part is treated separately and looked up in the membership database. 
n The first match found (searching left to right) as either a member's primary callsign or as a member's past/othercallsign will be used. 

l New Capabilities & Features: 
¡ Users can now use "double click" on a Log List Box row as a request to edit the entry. 
¡ The Log Entry Window now includes an option to list "Partial Matches" of callsigns. The list is updated for every character entered and is finalized when the callsign entry is complete. Actual duplicate entries (same Call and same Band) are highlighted with a reddish background. 
¡ A "Add SKCC Numbers to Log" function has been added to the Tools Menu. This allows logs imported from other logging programs to be quickly updated with SKCC Numbers. 
¡ Added "Alt-S" shortcut to Log Entry Window as a shortcut for "Save" - same as hitting "Log It" button.

l Changes to how the program works - not "seen" or necessarily noticed by the user: 
¡ In the Delete Log Entry prompt, if the Frequency is blank, then the Band is listed. 
¡ If the user-entered band value does not include an "M", then the program appends one for the user.
¡ When the logging mode is anything other that CW, then only the first two characters of the Default RST's are used as auto-fill values. 
¡ At program startup, the program now looks for a membership (skcclist.txt) file that is newer than the last one downloaded by the program. If one is found, the membership database will be loaded from the new file. This processing allows a user to download the list by themselves and copy it to the folder for the program to use. 
¡ Changed the processing for recovering from an Abnormal Shutdown to give the User the option to recover the previous log or start with no log file. 
¡ The Main Log List Box now recognizes the Ctrl-A key sequence as a shortcut to Select All rows. 
¡ All columns in the Main Window Log List Box are now User Resizable. Previously, the Row ID, Date, and Time columns 
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were not resizable. 
¡ Added an input Mask of "##:##:##Z" to the QSO Time fields in the Log Entry and Log Edit Windows. The mask makes it a bit easier to manually enter times. 

v01.01.01, 2013-02-23:
l Changes to previous processing methods:

¡ Removed "SPC Details" Push Button - Now just click on the "SPC Count" label. 
¡ Moved the "Reset Saved Window Position" option to the new Tools Menu. 
¡ Changed Log Entry and Log Edit processing to allow for users who want to mouse click from field to field rather than using the Tab or Enter Keys. 
¡ Changed Main Log List Box display by adding a Horizontal scroll bar, adding columns for Mode and RX Power, making most columns resizable, and allowing a smaller minimum width for the Main Window..
¡ Added ability for user to select which columns are displayed in the Main Window Log List Box. 
¡ Main Window Log List Box column widths are now remembered and restored. 
¡ You can now Edit or Delete a single record in two ways. As in the past, you can right click a row and select either "EditRow" or "Delete Row" from the context sensitive menu, or you can use the Main Window "Edit Row(s)" or "Delete Row(s)" buttons. 

l New Capabilities & Features: 
¡ Added Tools Menu option to "Recover From Backup". This option provides the ability to recover from a catastrophic failure or operator error. It also provides a limited "Roll Back" option for the current Log. 
¡ Added Mouse Wheel QSY Scroll at rate of +/- 100 Hz per click. 
¡ Added "Run/S&P" Push Button to Log Entry Window to swap RST Tx and RST Rx assignments. 
¡ Added Program Option to select maximum number (2 to 25) of Recent Logs to maintain in the Reopen Recent Log list. 
¡ Added File Menu option to clear Recent Log List.
¡ Added support for TenTec Argonaut V. 
¡ Added a "Edit Row(s)" push button to the Main Log Window to provide for Editing of 1 or more selected rows. 
¡ Added a "Delete Row(s)" push button to the Main Log Window to provide for Deletion of 1 or more selected rows. 

l Changes to how the program works - not "seen" or necessarily noticed by the user:
¡ Added code to Log Entry window to save/restore control focus whenever a push button or checkbox is clicked. 

v01.01.00, 2013-01-26: (Major Upgrade Release)
l Bug Fixes:

¡ Fixed a bug that would cause a "NilObjectException" when printing with no log file (Nil Database). 
¡ Fixed a bug that caused the sprint bonus to be lost when doing a file merge. 
¡ Fixed a bug that caused you to lose RX Power in the Log Edit Window. 

l Changes to previous processing methods: 
¡ Added "DC" as a recognized US State Abbreviation and fixed the Canadian Province abbreviation for Newfoundland - was "NF" and should have been "NL". 
¡ Started treating TX & RX Power as floating point value rather than as an Integer. Now Decode and display RX & TX Power in Edit Window only if Numeric and greater than 0. 
¡ Stopped saving blank fields in an ADIF file and stopped decoding blank FREQ entries when loading an ADIF file. 
¡ Removed "Close Logger" Button from Main Window.
¡ Added Message Box when user tries to shutdown with Log Entry window still open. 
¡ Renamed File Menu option "Save Log Data To..." to "Save Log As...". 

l New Capabilities & Features: 
¡ Added "QSY" option with Auto-Clear option to Add Log Entry Window. 
¡ Added capability to save and recall more than one radio setup. 
¡ New processing checks for a "partial" log entry when the Log Entry window is closed. If it appears that a log entry was started but not completed, the User is warned with an option to either close the window or cancel and go back. 
¡ Added a Program Option to Save & Recall last window positions and Sizes. This was a non-user controlled action in prior versions. 
¡ Added a Menu Option to Reset ALL Window Positions. 
¡ Added a File Menu option "Save Selected As..." to save selected entries to an ADIF File. 

l Changes to how the program works - not "seen" by the user: 
¡ Changed the way the User Guide is launched to be viewed. 
¡ Added startup processing to determine if the Main window's last saved position is still valid. This processing handles the case where a user had the Main window on a monitor that has been removed since the last time the program was run. 

v01.00.10A, 2012-12-20:
l Fixed a bug in the Log Entry and Log Edit windows that would incorrectly list a similar call as a duplicate call. For example, W1XY would list as a duplicate with W1XYZ. 
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l Fixed a bug in the Log Entry process that would not allow you to manually enter any date other than current date. 

v01.00.10, 2012-12-10:
l Added Program Option to refill Log List Box whenever the Main Window is resized. 
l Added Program Option to log Transmission Modes of CW/SSB/AM/FM. 
l Modified processing in the "Log Entry" and "Log Edit" windows to change the way non-blank fields are affected by auto-fill processing. If any auto-fill fields are non-blank the operator is presented with three options of how to handle non-blank fields: "Overwrite", "Fill-In Blanks", or "Leave All As-Is". 
l Modified Program Options processing to allow unlimited maximum web download wait time. Also added informative messages of invalid or questionable values. 
l Added an "Auto Log" option in the log Entry window to control the action of the "Enter" key. If enabled, the "Log It" action is the default action for the "Enter" key. If disabled, then the user must click the "Log It" button to complete a log entry. 
l Changed startup processing to use existing membership RealSLQ Database rather than rebuilding it from the existing skcclist.txt file.
l Changed Log Entry Date and Time tracking by freezing date and time when a callsign is entered and added the "Now" button to the Log Entry Window.

v01.00.09, 2012-11-16:
l Changed USA Country setting from "USA" to "United States". 
l Modified the procedure that loads an ADIF Log File to NOT load a duplicate (same DATE/TIME/CALL/MODE) record. 
l Fixed some bugs in the Log Entry and Log Edit routines that would cause an incorrect date to be logged when data was entered or edited between local New Day and Zulu New Day.
l Added Print function to the File Menu. 

v01.00.08a, 2012-10-15:
l Changed membership data download routine to eliminate null characters in file downloaded from server. 
l Fixed bug introduced in v01.00.08 to handle alternate calls. Some data lines have less than 6 fields in the membership file and these records were not processed properly. 
l Fixed bug in "Check SKCC" processing that would return only the callsign but not the membership info. 

v01.00.08, 2012-10-06:
l Added Icom IC-7200 to Radio Selection list.
l Fixed bug that prevented user from saving/restoring a non-standard Icom CIV Port value. 
l Added Icom IC-703 to Radio Selection list. 
l Added recognition of Canadian Territories NT, NU, and YT to Logger. 
l Added code to check "Alternate/Past" Callsigns during Log Entry. 

v01.00.07, 2012-08-20:
l Added code to save and restore the position and size of each window used by the application. 
l Changed Construct Contextual Menu code to allow Edit or Delete options even when the Log Entry window is open. 
l Eliminated the "Log Changes will be saved" label from the Log Entry Window. 
l Converted the User Guide from a plain text file displayed in a separate window to a Compiled Hypertext (.chm) file format. 

v01.00.06, 2012-08-11:
l Bug Fix: Log Entry "Clear All" button now resets all text field background colors. 
l Added code: Clicks on Main Log List Box will alternately select/de-select the row. 
l Changed Log Edit Open code: "Save Changes" button is now initially enabled. 
l Added Elecraft KX3 Radio to selection drop down list. 

v01.00.05, 2012-07-27:
l Modified Frequency display to be to Hertz level - decimal MHz with 6 digits after decimal point. 
l Modified TX & RX RST validation tests. 
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l Modified TX & RX Power Validation tests. 
l Minor tweaks to some window form labels. 

v01.00.04, 2012-07-15:
l Major revision to handling computation and display of sprint statistics. 
l Added Sprint Bonus entry box with value saved in Sprint info Table of Log Database File and also in ADIF Header of a log file. 
l Added SPC Details Display Window. 

v01.00.03, 2012-06-20:
l Fixed oversight that made "RX Pwr" sticky on the Log Entry window - its contents were not being cleared by the code.
l Added label to the Previous QSO List Box in the Log Entry and the Log Edit Windows. 
l Changed code to prevent overwriting current field in Log Entry window when using auto-fill. There was a problem that a previously entered RST or Name would be overwritten if the "Check Call" or "Check SKCC" button was pressed or is if the Callsign field lost focus again. 
l Added "Export to CSV" menu option. 
l Changed the Date Text Field format label in the Log Entry and Log Edit Windows to show current format based on local RegionalSetting on the PC. 
l Made minor change to how the frequency write command for Ten-Tec radios is created to ensure that there are always 4 bytes in the frequency value. 
l Modified Global "LoadRadioInfo()" method to make future additions and re-ordering of radios easier. 
l Added interface for TenTec Omni VII. 
l Added interface for TenTec Omni VI Plus. 
l Added interface for Yaesu FT-920. 
l Added keyboard shortcuts to Log Entry window. 
l Changed Radio Setup Window to preset Pull-Down selections to previous values, eliminated previous setting labels, and deleted clear setup button.
l Changed Radio Setup Window. The "Open Port"/"Close Port" Pushbutton is now the same button. Also moved the setting for polling rate of the radio's VFO from the Program Options Window to the Radio Setup window. 

v01.00.02, 2012-06-07:
l Fixed a bug that changed the Country to "DX" during log entry or log edit when the leaving the State field with an abbreviation that was not either a US State, US Possession, or Canadian Province. Will now set the Country field to "DX" ONLY if the Country field is Blank and the State field is not an abbreviation for a US State, US Possession, or Canadian Province. 

v01.00.01, 2012-06-07:
l Enhanced, corrected, and added Source Code documentation and comments. 
l Added the "Copy to Clipboard" push button to the Radio Setup window. 
l Changed Global "GetRadioFreq" and "SetRadioFreq" methods to add status to Raw Data List Box. 
l Deleted calls to RadioPort.XmitWait() after sending commands to radio. 
l Deleted calls to RadioPort.Reset() before sending commands to radio. 

v01.00.00, 2012-05-31:
l Initial, non-Beta, release.

Next section: To-Do List and Known Bugs
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To-do List and Known Bugs
Just about every program remains incomplete - there always seems to be something that could be added. At the same time, most programs also have known bugs or shortcomings - this program is certainly no exception.
The following lists identify those enhancements or additions currently on the "To Do" list and known bugs or issues that have been reported or discovered.
To-Do List:

l Look into adding processing for Maple Leaf awards. 
l Look into adding QRP option for DX Awards. 
l Change Update Sprint Stats to a Thread. 
l Revise Print Log processing to only print the columns displayed. 

¡ Or, maybe even, prompt for which fields to print and in what order. 
l Change some time consuming and compute intensive processing to threads to keep the program from appearing that it is not responding when handling a large file:

¡ File Save, File Load, and Fill List Box; 
¡ Save Selected As;
¡ Award Processing. 

Identified Bugs:
l Not a real bug, but the program can appear to hang up when opening a very large log file. The program has been tested with a log file containing over 15,000 log entries but opening the log takes a very long time. 

73, Ron, AC2C
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